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Introduction 

Digital Audio Broadcasting (DAB) is the most widely adopted technology for digital radio broadcast-
ing. DAB-based standards, including the recently developed DAB+ and DMB, support video and data 
services in addition to audio service. 

The British standard, BS EN 50248 “Characteristics of DAB Receivers”, describes DAB receiver 
characteristics for commercial equipment intended for terrestrial and cable reception in band III and 
L- band and for satellite reception in L-band.

This document discusses the measurement configurations and procedures for DAB receiver RF 
performance test using Keysight Technologies, Inc. instruments, according to BS EN 50248.
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Demonstration Preparation 

Equipment requirements

Upgrade to the latest firmware
The following instruments and software are required to perform all of the dem-
onstrations found in this guide. It is strongly recommended to update instrument 
firmware and software to the latest versions. 

Signal Studio for broadcast radio software: www.keysight.com/find/N7611B
PXB baseband generator and channel emulator: www.keysight.com/find/sg_firmware
MXG vector signal generator firmware: www.keysight.com/find/sg_firmware

Try before you buy!

FREE 14-day trial of Signal Studio 
software is available and provides 
unrestricted use of features and 
functionality. Redeem a trial license 
today for your existing MXG signal 
generator online at:

www.keysight.com/find/signalstudio_trial

Product description Model number Required options

PXB baseband generator 
and channel emulator

N5106A Option186, digital video application bundle, including 
- Option 612, 2 DSP blocks on 1 baseband card 
- Option 632, 2 I/O ports - 2 analog I/Q out and 2 digital I/O on 1 I/O card 
- Option EFP, baseband generation 
- Option JFP, calibrated AWGN 
- Option QFP, fading with SISO channel models

MXG RF vector signal 
generator

N5182A Option 503/506, frequency range from 250 kHz to 3 GHz/6 GHz

Signal Studio for broadcast 
radio

N7611B Option 6FP, connect to N5106A PXB 
Option RFP, advanced DAB 
Option SFP, ETI support 
Option QFP, advanced FM Stereo/RDS

PC with Signal Studio 
software installed

Install Signal Studio software to generate and download the signal waveform into the MXG 
signal generator via GPIB or LAN (TCP/IP). Please refer to the Signal Studio software Help 
for installation instructions and PC requirements.

www.keysight.com/find/N7611B
www.keysight.com/find/sg_firmware
www.keysight.com/find/sg_firmware
www.keysight.com/find/signalstudio_trial
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Setup diagrams
The setup diagrams of the test system are shown in Figure 1 and Figure 2, 
which are based on the equipment previously listed. The block diagrams are 
slightly different for different demonstrations.

Figure 1. Setup diagram for sensitivity, maximum input power, and sensitivity in Rayleigh channel tests.

Figure 2. Setup diagram for selectivity and acquisition time after synchronization loss tests.
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DAB Receiver Test Demonstrations 
Overview of requirements for DAB receiver test
BS EN 50248 includes both basic and functional performance requirements 
for DAB receivers, as well as the minimum performance levels and measuring 
methods. The RF performance tests stipulated in the standard are as follows.

–– Sensitivity in a Gaussian channel
–– Maximum input power in a Gaussian channel
–– Selectivity, including two parts:

–– Adjacent channel selectivity
–– Rejection of unwanted signals (far-off selectivity)

–– Performance in a Rayleigh channel
–– Sensitivity

–– Acquisition time after synchronization loss

All the measurements listed above need to be performed in both the VHF band 
and the L-Band as below:

–– VHF Band III: 174 MHz ~ 240 MHz
–– L-Band: 1452 MHz ~ 1492 MHz

The BER result of 10-4 is used as the criteria in all tests. The BER should be mea-
sured at the convolutional decoder output of the receiver and performed in the 
MSC (Main Service Channel) using an EEP (equal error protection) sub-channel 
with code rate ½. Note that while some receivers can provide BER results, if 
they cannot, an extra BER meter is required to measure the BER results. Any 
known digital pattern with a length of more than 1 symbol can be used as the 
test sequence – for example, all zero sequence.
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Signal Studio software Software operation

Start the Signal Studio for  
broadcast radio software.

Click Start > All Programs > Keysight 
Signal Studio > Broadcast Radio >  
Broadcast Radio

To generate DAB waveforms: 
Select the DAB format.

Click on the Format pull-down menu at the 
top of the Signal Studio program window. 
Next, select DAB

Configure the DAB signals to 
meet the requirements of the 
standard (BS EN 50248).

In the tree view, left pane of the main win-
dow, click Carrier 0, and then in the right 
pane, set the DAB transmission mode, for 
example: 
Transmission Mode = Mode 1. 

In the tree view, click Ensemble and 
set the payload. If the payload is set to 
ETI(G.703) or ETI Demo (G.703), the soft-
ware will read the parameters for services 
and service components from the ETI file; 
If the payload is set to By Each Service 
Component, click Services and Service 
Components in the tree view to configure 
the service.

Note that the BER test should be made in 
the MSC (Main Service Channel) using an 
EEP (equal error protection) sub-channel 
with code rate ½. Then under Service 
Components in the tree view, on the right 
pane the settings should be:

Long Form = True
Protection Level = EEP 3-A
Convolutional Coding Rate = 1/2

To generate FM waveforms:
Select the FM format.

Click on the Format pull-down menu at the 
top of the Signal Studio program window. 
Next, select FM Stereo/RDS

Set up signal studio for broadcast radio
To make the test, first generate the required waveforms using N7611B. Wave-
forms of two standards are required:

–– DAB waveforms as defined in EN 300 401 for the wanted signals
–– Standard FM modulated waveform as defined in EN 60315-4 as the interference 

signal (this signal is used in the selectivity test)
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Figure 3. N7611B Signal Studio for broadcast radio

Configure the software to gener-
ate standard FM waveforms as 
defined in EN60315-4.

In the tree view, left pane of the main 
window, click Carrier 0 and in the right pane 
set:
FM Deviation = 67.5 kHz
Audio Source Pattern = L Only
RDS = Off

Generation and save settings:
Generate the required waveform. Click the Generate Waveform button  on 

the tool bar
Export and save the waveform 
for future use.

File > Export Waveform Data > DAB.wfm 
or FM.wfm (create file name)
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Signal Studio software Software operation

Start N5106A PXB. Start > All Programs > Keysight N5106A 
PXB > N5106A PXB Baseband Generator 
and Channel Emulator

Configure PXB to be a one-
channel baseband generator 
to play the DAB waveform and 
connect it to MXG (Figure 4).

Select 1 Channel configuration under 
Generate in the Configuration Browser. 

Under the Block Diagram tab in the 
(Unassigned) block, click the    button 
to display the Assign External Instrument 
dialog box. Then follow the on-screen 
instructions to connect to the MXG.

Click the Load Configuration button at the 
bottom to load the configuration

Load the DAB waveform gener-
ated by the N7611B software and 
play it. All required waveforms 
can be stored in the hard disk of 
the PXB (Figure 5).

Select User File 1 (ARB) in the Settings 
Browser and in the Waveform Source 
Name cell, load the DAB waveform gener-
ated with N7611B signal studio.

Click   button to enter the 
window where you can download the 
selected waveform into PXB memory and 
click the Start button at the bottom of the 
window to start downloading

Set the frequency of the output 
signal and play the waveform. 
Note that the test needs to be 
performed in both VHF band and 
L-band.

Select the MXG (output) label in the 
Settings Browser and set the frequency 
of the DAB signal in the Frequency cell 
under General Settings tab. 

Click the    button at the right top of 
the window to play the waveform

Sensitivity and maximum input power in a Gaussian channel
Sensitivity and maximum input power are the minimum and maximum input 
signal levels of the DAB receiver at which the BER result meets the criteria as 
stipulated in BS EN 50248. The setup diagram for this test is shown in Figure 1. 

For the sensitivity test, the minimum requirement in EN 50248 is –81 dBm for 
both VHF band and L-band. If the measured power is lower than this value, it 
means the receiver passes the sensitivity test. For the maximum input power 
test, the minimum requirements for different types of DAB receivers defined in 
EN 50248 are listed in Table 1. If the measured power is higher than this value, 
it means the receiver passes the maximum input power test.
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Figure 4. PXB configuration as 1 channel

Figure 5. Loading the waveform

Table 1. Minimum requirements for maximum input power
Power 
requirement

Mobile 
receiver

Stationary receiver Portable 
receiver

VHF band –10 dBm –15 dBm –20 dBm
L-band –25 dBm –25 dBm –25 dBm

Reduce the input power of the 
DAB receiver until the BER 
reaches 10-4, and then record this 
power value as sensitivity. Note 
that you may need to take the 
attenuation of the cable connect-
ing the MXG and DAB receiver 
into consideration.

Select the MXG (output) label in the 
Settings Browser and adjust the ampli-
tude of the DAB signal in the Amplitude 
cell under General Settings tab

Increase the input power of 
the DAB receiver until the BER 
reaches 10-4, and then record this 
value as maximum input power.

Select the MXG (output) label in the 
Settings Browser and adjust the amplitude 
of the DAB signal in the Amplitude cell 
under General Settings tab
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Selectivity
Selectivity tests reception performance in the presence of unwanted signals. 
The setup diagram for this test is shown in Figure 2. Two types of measure-
ments need to be conducted here: adjacent channel selectivity and far-off 
selectivity.

–– For the adjacent channel selectivity measurement, both the wanted and 
unwanted signals are DAB signals and the frequency separation between 
them is 1.712 MHz. The adjacent channel selectivity (Acs) is expressed as: 
 
Acs = Punwanted – Pwanted = Punwanted + 70 (dB) 
 
If Acs is larger than or equal to 30 dB in both the VHF band and the L-band, 
the DAB receiver passes the adjacent channel selectivity test. 

–– For the far-off selectivity test, the unwanted signal is the FM modulated 
signal and its center frequency needs to be more than or equal to 5 MHz 
away from the wanted DAB signal. The far-off selectivity, which is also called 
rejection of the unwanted signal, is expressed as: 
 
Rr (rejection ratio) = Punwanted – Pwanted = Punwanted + 70 (dB) 
 
If Rr is larger than or equal to 40 dB in both the VHF band and the L-band, the 
DAB receiver passes the far-off selectivity test.

On the PXB Operation

Start the N5106A PXB. Start > All Programs > Keysight N5106A 
PXB > N5106A PXB Baseband Generator 
and Channel Emulator

Configure the PXB to be a two-
channel baseband generator, 
which plays two waveforms (the 
wanted and unwanted signal) 
separately.

Select the 2 Channels configuration under 
Generate in the Configuration Browser. 

Under the Block Diagram tab in the two 
(Unassigned) blocks, click the    button 
to display the Assign External Instrument 
dialog box. Then follow the onscreen 
instructions to connect to the two MXGs

Click the Load Configuration button at the 
bottom to load the configuration
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Figure 6. PXB configuration with two channels

Load the required waveforms 
for each channel. The required 
waveforms are two DAB wave-
forms for the adjacent channel 
selectivity measurement and 
one DAB waveform and one FM 
waveform for the far-off selectiv-
ity measurement.

Select User File 1 (ARB) in the Settings 
Browser and in the Waveform Source 
Name cell, load the DAB waveform gener-
ated with N7611B signal studio as the 
wanted signal.

Select User File 2 (ARB) in the Settings 
Browser and in the Waveform Source 
Name cell, load the DAB or FM waveform 
generated with N7611B signal studio as 
the unwanted signal.

Click    button to enter the 
window where you can download the 
selected waveforms into PXB memory and 
click the Start button at the bottom of the 
window to start downloading

Set the frequency of each chan-
nel in the PXB or MXG directly 
and maintain their difference as 
stipulated in the standard, then 
play the waveforms.

Select the MXG1 (output) label in the 
Settings Browser and set the frequency 
of the DAB signal in the Frequency cell 
under General Settings tab.

Select the MXG2 (output) label in the 
Settings Browser and set the frequency 
of the unwanted FM or DAB signal in the 
Frequency cell under General Settings 
tab.  

Click the    button at the right top of 
the window to play the waveforms.

Set the power level of the 
wanted signal to –70 dBm and 
increase the power level of the 
unwanted signal until the BER 
result reaches 10–4, and then 
record this value as Punwanted.

Select the MXG1 (output) label in the 
Settings Browser and set Amplitude = 
–70 dBm

Select the MXG2 (output) label in the 
Settings Browser and adjust the ampli-
tude of the unwanted signal in Amplitude 
cell
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Performance in a Rayleigh channel
The mobile environment is a typical reception condition for DAB receivers. 
Especially for car DAB receivers, the wireless channel is highly dynamic. Chan-
nel models will include the Doppler-effect, as well as multi-path reception, plus 
fast and slow fading. To simulate the transmission environment, BS EN 50248 
defines several channel profiles. Different frequencies and DAB receive modes 
are defined for tests under different channel conditions, as listed in Table 2. See 
Appendix A for the details of the channel profile definitions. The setup diagram 
for this test is given in Figure 1.

Table 2. Channel simulation profiles of defined frequency bands and DAB modes 
Frequency DAB mode Channel profiles

225.648 MHz I Urban at 25 km/h
Rural at 120 km/h
SFN at 60 km/h 

1471.792 MHz II Urban at 25 km/h
Rural at 120 km/h

1471.792 MHz IV Urban at 25 km/h
Rural at 90 km/h

On the PXB Operation

Start the N5106A PXB. Start > All Programs > Keysight N5106A 
PXB > N5106A PXB Baseband Generator 
and Channel Emulator

Configure the PXB as shown in 
Figure 7. In this case, one DSP is 
used to play the DAB waveform 
and the other DSP is configured 
to be a fader to simulate the 
propagation channel.

Select the 1 Channel configuration under 
Generate and Fade in the Configuration 
Browser. 

Under the Block Diagram tab in the 
(Unassigned) block, click the    button 
to display the Assign External Instrument 
dialog box. Then follow the onscreen 
instructions to connect to the MXG. 

Click the Load Configuration button at the 
bottom to load the configuration.

Load the DAB waveform into 
the PXB. The mode of the DAB 
waveform needs to be compliant 
with Table 2.

Select User File 1 (ARB) in the Settings 
Browser and in the Waveform Source 
Name cell, load the DAB waveform gener-
ated with N7611B signal.

Click   button to enter the 
window where you can download the 
selected waveforms into PXB memory and 
click the Start button at the bottom of the 
window to start downloading



14

Configure the channel profiles. Select Master Setup 1 label in the 
Settings Browser and set the Fader 1 
Carrier Frequency to the frequency of the 
DAB signal, for example, 225.648 MHz. 
Note that the carrier frequency needs to 
be correct because the Doppler frequency 
and vehicle speed under Fader 1 Paths will 
be coupled with that value.

Select Fader1 Paths label in the Settings 
Browser and set the parameters for each 
path as defined in Appendix A. Refer to 
“Multipath fading settings on the PXB” 
section below for the setup method of the 
five Doppler spectrums required in the 
channel profiles.

Set the frequency of the output 
signal and play the waveform.

Select the MXG (output) label in the 
Settings Browser and set the frequency 
of the DAB signal in the Frequency cell 
under General Settings tab.

Click the    button at the right top of 
the window to play the waveform

Adjust the power of the output 
signal to perform the test.

Select the MXG (output) label in the 
Settings Browser and adjust the ampli-
tude of the DAB signal in Amplitude cell

The procedure of adjusting the output signal power is as below:

1)	 Set the input power of the DAB receiver to a value such that the DAB 	
	 receiver is in an error- free reception mode, the BER is less than or equal to 	
	 10-4, and synchronization is good. 

2)	 Reduce power by 5 dB and make sure the synchronization is not lost. 

3)	 Read the BER value on the BER meter. If the BER is better than 10-4 for one 
	 minute, repeat 2) and 3) until the BER value is less than 10-4, and then 	
	 record the power. If it is larger than –75 dBm, the DAB receiver passes this 	
	 test for the current channel profile, mode, and frequency. 

4)	 Repeat the test to cover all the cases and channel profiles listed in Table 2 	
	 and the Appendix.

Figure 7. PXB configuration including a baseband generator and a fader
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Multipath fading settings on the PXB
Five Doppler spectrums are defined in the channel profiles in the Appendix, 
CLASS, RICE, GAUS1, GAUS2, and GAUSDAB. Below are the instructions for 
setting up these five Doppler spectrums in the PXB.

1)	 CLASS
	 This Doppler spectrum is used for paths with delays up to 0.5 µs.

	 Where τi ≤ 0.5 μs and fd is the maximum Doppler shift.

	 The Class Doppler spectrum is configured in the PXB as shown below. The 	
	 fading type is set to Rayleigh and the spectral shape is set to the Classical  
	 6 dB. The delay, loss, and vehicle speed are set as stipulated in the  
	 standard. The Doppler frequency is calculated automatically using the 	
	 vehicle speed and the carrier frequency.

2)	 RICE
	 RICE Doppler spectrum is the sum of a classical Doppler spectrum and a 	
	 direct path, as defined below.

	 Then the K factor is calculated as K = 10* log10 (               ) = 6.47 dB.

	 The Doppler spectrum of the LOS (line of sight) path is 0.7 fd, so the AOA 	
	 (angle of arrival) is arccos (0.7) *       = 45.57° .

	 Figure 9 shows the RICE Doppler spectrum configuration in the PXB.  
	 The Rician K is set to 6.47 dB and LOS AOA is set to 45.57°.

S(τi, f) = for f ε [–fd, fd]
A

1 – ( f―fd

)2

Figure 8. Class Doppler spectrum configuration

Figure 9. RICE Doppler spectrum configuration

0.41/ 2
0.91

π
180

S(τi, f) = + 0.91δ (f – 0.7fd)  for f ε [–fd, fd]
0.41

1 – ( f―fd

)22πfd
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3)	 GAUS1 and GAUS2
	 Both GAUS1 and GAUS2 are the sum of two Gaussian functions. GAUS1 is 	
	 for paths with delays from 0.5 µs to 2 µs, and GAUS2 is for paths with delays 	
	 larger than 2 µs. 

	 The definitions for GAUS1 and GAUS2 are shown below. In GAUS1, A1 is  
	 10 dB below A. In GAUS2, B1 is 15 dB below B.  

	 GAUS1: S(τi, f) = G(A, –0.8fd, 0.05fd) + G(A1, 0.4fd, 0.1fd)
	 GAUS2: S(τi, f) = G(B,0.7fd, 0.1fd) + G(B1, –0.4fd, 0.15fd)

	 To simulate the GAUS1 or GAUS2 Doppler spectrum in the PXB, two paths 	
	 are used to simulate one GAUS1 or GAUS2 path. Figure 10 is an example 	
	 of setting the GAUS1 Doppler spectrum by using two paths in the PXB fader 	
	 to simulate one GAUS1 path.

	 While configuring the GAUS1 or GUAS2 path, note the following:

–– 	The two paths used to simulate one GAUS1 or GAUS2 path have the 		
same spectral shape (Gaussian) and delay.

–– 	The losses of the two paths are 6 dB and 16 dB respectively, in which  
6 dB (A) is the loss of the current GAUS1 path and 16 dB (A1) is 10 dB 	
below A.

–– The frequency offset of each path is set to –0.8fd and 0.4fd as in the  
GAUS1 equation, where fd is the maximum Doppler shift. In this case, 	
fd is 5.227 Hz, so the frequency offset of the 1st path is set to –0.8*fd = 
4.18 Hz and that of the 2nd path is set to 0.4*fd = 2.09 Hz.  For GAUS2 	
Doppler spectrum, the frequency offsets should be 0.7fd and –0.4fd 	
respectively.

Figure 10. GAUS1 configuration
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4)	 GAUSDAB
	 The GAUSDAB Doppler spectrum is defined as follows: 

	 S(τi, f) = G (A, ±0.7fd, 0.1fd), 

	 where +0.7fd applies for even paths and –0.7fd for the odd, except path 1.

	 Figure 11 shows the configurations for the SFN channel profile in which the 	
	 GAUSDAB Doppler spectrum is used. The frequency offsets are set to 0.7fd 	
	 and –0.7fd for even paths and odd paths respectively.

Figure 11. GAUSDAB configuration in SFN channel profile

Acquisition time after synchronization loss
Acquisition time after synchronization loss tests the re-synchronization capabil-
ity of DAB receivers. In BS EN 50248, it is defined as “the time of audio mute 
between switching off the received ensemble and re-synchronizing to the same 
ensemble at an offset frequency”.

The setup diagram for this test is given in Figure 2. The PXB and two MXGs  
are used to generate the two DAB waveforms with the same ensemble at differ-
ent frequencies. The frequency difference between the two MXGs shall be half  
a carrier spacing, which are 500 Hz, 2000 Hz, 4000 Hz, and 1000 Hz for DAB 
mode I, mode II, mode III, and mode IV respectively. A mute detection device is 
used to measure the time it takes for the DAB receiver to resynchronize to the 
same ensemble.
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Then, on the two MXGs, turn on the RF outputs by pressing RF On/Off key and do the 
following:
1)	 Turn off the RF output of MXG 2 by pressing RF On/Off key on the MXG to let the 	
	 DAB signal from MXG 1 feed into the DAB receiver. 
2)	 Turn off the RF output of MXG 1. Wait at least 10 seconds, then turn on the RF 	
	 output of MXG 2 and test the time it takes for the DAB receiver to resynchronize to 	
	 the signal with the mute detection device. 
3)	 Repeat steps 1) and 2) five times, and then average the results of the five  
	 measurements. The average result is then recorded as the acquisition time after 	
	 synchronization loss. In BS EN 50248, it is required that the value be smaller than 	
	 3000 ms. 
Note that the measurement needs to be performed separately for all four DAB transmis-
sion modes.

On the PXB Operation

Start the N5106A PXB. Start > All Programs > Keysight N5106A PXB 
> N5106A PXB Baseband Generator and 
Channel Emulator

Configure the PXB to be a two-
channel baseband generator, 
which plays two waveforms 
separately. 

Select the 2 Channels configuration under 
Generate in the Configuration Browser. 
Under the Block Diagram tab in the two 
(Unassigned) blocks, click the    button 
to display the Assign External Instrument 
dialog box. Then follow the onscreen instruc-
tions to configure the IP addresses of two 
MXGs.
Click the Load Configuration button at the 
bottom to load the configuration.

Load the same DAB waveform for 
each channel.

Select User File 1 (ARB) in the Settings 
Browser and in the Waveform Source Name 
cell, load the DAB waveform generated with 
N7611B signal studio.
Select User File 2 (ARB) in the Settings 
Browser and in the Waveform Source Name 
cell, load the same DAB waveform. 
Then click    button to enter 
the window where you can download the 
selected waveforms into PXB memory and 
click the Start button at the bottom of the 
window to start downloading

Set the amplitude and frequency 
for each channel and play the 
waveforms. The amplitudes of the 
two channels are the same and 
the frequency difference should be 
set according to the current mode 
of the DAB waveform (500 Hz for 
mode 1).

Select the MXG 1 (output) label in the 
Settings Browser and set the frequency 
in the Frequency cell and amplitude in the 
Amplitude cell under General Settings tab.
Select the MXG2 (output) label in the 
Settings Browser and set the frequency 
in the Frequency cell and amplitude in the 
Amplitude cell under General Settings tab.
Click the    button at the right top of 
the window to play the waveforms
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Appendix - Channel Profiles

This appendix lists the channel profiles used to simulate multipath fading in the 
wireless propagation channel for “Performance in a Rayleigh channel” test as 
defined in BS EN 50248. There are three types of channel profiles, which are for 
rural areas, urban areas, and SFN networks respectively.

Table 3 includes channel profiles for rural areas, including 4 paths and 6 paths 
respectively. Table 4 includes channel profiles for urban areas, including 12 
paths and 6 paths respectively. Table 5 includes channel profiles for SFN (single 
frequency networks) in the VHF band.

Table 3. Channel profiles for typical rural (non-hilly) areas
4 paths
Path number Delay (µs) Loss (dB) Doppler type SD (µs)

1 0 0 RICE
2 0.2 –2 CLASS 0.1 ± 0.02
3 0.4 –10 CLASS
4 0.6 –20 CLASS

6 paths
Path number Delay (µs) Loss (dB) Doppler type SD (µs)

1 0 0 RICE
2 0.1 –4 CLASS
3 0.2 –8 CLASS 0.1 ± 0.02
4 0.3 –12 CLASS
5 0.4 –16 CLASS
6 0.5 –20 CLASS

Table 4. Channel profiles for typical urban (non-hilly) areas
12 paths
Path number Delay (µs) Loss (dB) Doppler type SD (µs)

1 0 –4 CLASS
2 0.1 –3 CLASS
3 0.3 0 CLASS
4 0.5 –2.6 CLASS
5 0.8 –3 GAUS1
6 1.1 –5 GAUS1 1.0 ± 0.1
7 1.3 –7 GAUS1
8 1.7 –5 GAUS1
9 2.3 –6.5 GAUS2
10 3.1 –8.6 GAUS2
11 3.2 –11 GAUS2
12 5.0 –10 GAUS2
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Table 5. Channel profile for single frequency networks (SFN) in the VHF band
Path number Delay (µs) Loss (dB) Doppler type SD (µs)

1 0 0 CLASS
2 100 –13 GAUSDAB
3 220 –18 GAUSDAB
4 290 –22 GAUSDAB
5 385 –26 GAUSDAB
6 480 –31 GAUSDAB
7 600 –32 GAUSDAB

6 paths
Path number Delay (µs) Loss (dB) Doppler type SD (µs)

1 0 –3 CLASS
2 0.2 0 CLASS
3 0.5 –2 CLASS 1.0 ± 0.1
4 1.6 –6 GAUS1
5 2.3 –8 GAUS2
6 5.0 –10 GAUS2

Additional Resources 
Standards referenced
[1] BS EN 50248 Characteristics of DAB Receivers
[2] ETSI 300 401 Radio Broadcasting Systems; Digital Audio Broadcasting (DAB) 
to mobile, portable and fixed receivers
[3] BS EN 60315-4 Methods of measurement on radio receivers for various 
classes of emission – Part 4: Receivers for frequency-modulated sound broad-
casting emissions

Web resources
Digital video industry webpage: www.keysight.com/find/digital_video
N7611B Signal Studio for broadcast radio: www.keysight.com/find/N7611B
N5106A PXB product webpage: www.keysight.com/find/N5106A
N5182A MXG product webpage: www.keysight.com/find/N5182A

Related literature

Signal Studio software brochure, literature number 5989-6448EN 
N7611B software technical overview:
http://wireless.keysight.com/wireless/helpfiles/n7611b/n7611b_techni-
cal_overview.pdf

www.keysight.com/find/digital_video
www.keysight.com/find/N7611B
www.keysight.com/find/N5106A
www.keysight.com/find/N5182A
http://wireless.keysight.com/wireless/helpfiles/n7611b/n7611b_technical_overview.pdf
http://wireless.keysight.com/wireless/helpfiles/n7611b/n7611b_technical_overview.pdf
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